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1. Introducéo

A programacao para CNC de pecas simples pode ser feita diretamente na
linguagem de maquina, utilizando o codigo ISO de programacao.

Alguns fabricantes de CNC desenvolvem ciclos de usinagem que facilitam
o trabalho do programador em pecas com perfis comuns na inddstria
mecanica, como ciclos de furagéo, ciclos de desbaste, rosqueamento, entre
outros.

Porém para a programacdo de pecas com superficies complexas, o
trabalho aumenta, especialmente em funcdo dos céalculos necessarios para
encontrar as trajetorias de ferramentas que irdo produzir a peca. Nestes
casos é recomendavel a utilizacdo de programas de computador que facilitem
o trabalho do programador.

Com o desenvolvimento da computacdo grafica, surgem alguns
programas de interesse dos programadores:

CAD — COMPUTER AIDED DESIGN

Os programas de CAD auxiliam o projetista a desenvolver o produto com
o0 auxilio do computador. A idéia do projeto € esbocada através de um
desenho que representa as formas e dimensfes adequadas do produto.

CAM — COMPUTER AIDED MANUFACTURING

Os programas de CAM auxiliam o programador CNC a realizar o seu
trabalho graficamente. Apds a peca ter sido desenhada no CAD, é possivel
abrir o modelo grafico diretamente nos programas de CAM.

Atualmente hd um misto de programas para desenho e manufatura que
executam as duas funcdes, os chamados programas CAD / CAM.
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2. Edge CAM 7.00

Para iniciar o programa aponte para o icone EdgeCAM no Desktop de
seu computador :

Ou entao através do menu :

Iniciar > Programas > EdgeCAM > EdgeCAM

% Acessdrios
% Inicializar r
g Internet E <plarer
m Outlook Express
E Prompt de comanda ﬁ Code Generator

@ ‘windows NT Explorer E Code Wizard
ﬁ Commg Setup

M e
@ Ferramentas administrativas [Comum)  » @ EdgeCAM Help
@ Feramentas do Microsoft Office Lz c@ EdgeCAM Tutorials
(3 Inicializar L4 E ditar
>
@ Mzzmmmzdl EQ Installation Guide
@ MTS CMC Demaversion [Spanish] 3 !a Job Manager
|3, Solidworks 2001 * & Job Reports
ol (= wirzip 3
% Abiir documento do Office &) Pathtrace Website
) o Microsoft Encel B=3 Sample Lathe
ovo documento do Office i
._0-4 Micrasoft Outlook. B Sample Mil
Microsoft PowerPoint o Sample Wi

logramas W] Microsoft Word

Documentos L3

h Technology Assistant
w Toolkit Assistant

LL
@ Lonfiguragties 3 ToolStore
g ﬁ User Licensas
fh EQ Ultilities
Dreal w\f'emfy
o 4 Verify TS

@ wihat's New

825

Prof. Claudimir José Rebeyka/ Prof. Ricardo Adriano dos Santos 3



PROGRAMACAO CNC
ENSITEC

2.1.Criando um novo arquivo

Apés a abertura do programa, atomaticamente € aberto um arquivo
novo em uma tela padrdo de trabalho. Pode-se também criar um novo
arquivo, com o programa ja aberto, através do menu file 2 new.

EdgrCAM - Liconsed 1o LMD - Prart. ppf

=4
P OHe Bt yew | Geomelry| Gutace Rolwy  [eemion  Sods Vedy  Custon Optors Rel R
TVl = =t MY Y TP AT s R IR W7 v Sk

S e T | 1 (o - A e e L o

Layers
M Shinw
'l;mmn-f Wirg

ko]

Fdhack F;-
-
3
4

. :

T IO G O .1 TN - o = =

E possivel abrir um arquivo do EdgeCAM através gerenciador de
arquivos do Windows, com um clique duplo diretamente sobre o nome do
arquivo.

Como por exemplo:

= = Torneamento
é EdgeaM Part
117 KE

2.2.Escolhendo o plano de trabalho XY ou ZX

Escolhendo criar um novo arquivo aponte para 0 menu:
Menu Options = ZX environment (Ambiente ZX)
Escolha também a opc¢éao:

Menu Options = Diametral Mode (Modo de diametro)
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Desta forma todas as coordenadas na direcdo X serdo consideradas
como valores expressos em diametro.

Veja outros elementos importantes da tela inicial:

No centro da tela de desenho, é apresentado a origem do
plano de trabalho, chamada de CPL (Construction Plane).

A seta AZUL indica a direcéo do eixo Z
A seta VERMELHA indica a dire¢ao do eixo X
A seta VERDE indica a direcdo do eixo Y

No canto inferior esquerdo da tela de desenho, é
apresentado o plano de trabalho, bem como a escala de
apresentacao do desenho na tela. Com um clique duplo
sobre 0 nome da vista é possivel selecionar outra vista
para o desenho.

_""'-' B | Fﬁ . — » GEometry -
L | —

O programa foi desenvolvido para ambiente Windows, possibilitando
funcdes como Novo arquivo, Abrir arquivo, Salvar e Imprimir através de
botbes. Também é possivel organizar o desenho através de Layers
(Camadas). Para cada Layer é associado um tipo de linha e uma cor
especifica. A Layer padrédo do programa é Geometry (Geometria).

Marme Shai
Ge::nmetr':.f Yes

Logo abaixo, no canto esquerdo da tela de desenho existe um Browser
(Navegador), com todas as Layers. Com clique duplo sobre a palavra Yes
(Sim) na coluna Show (Mostrar) é possivel mostrar / esconder uma camada.

Para ativar o Browser, aponte para :

View - Status Bars - Browser (Navegador)
Ou use o atalho das teclas Alt + B
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2.3.Acertando as preferéncias do usuario
E possivel acertar as preferéncias do usuario através do menu:
Options > Preferences (Preferéncias)

Que abre a seguinte caixa de dialogo:

Preferences

 Gereral | Suifaces | Toolpaths | Tool Libraries | Modality | Selection | Very | Solids |

Autosave [ A - PartUrits
Errvironmment o o Ithes
or ) Millimatres
Oz [] Feedback Dialog
Dizplay Mode Buttons

Tolerances
Spsterm DEI1 Dizplay '-|:|_1
Maouze Wheel Senzitivit (1.2
|mpaork .
[#] New IGES Impart [«] Mew IGES Export
[] Mew DG /D<F Impart Mew DA E/DXF - Explode Blocks
Mew DWG/DF Log Folder |
Shrategies
Strateqgy Folder :-Ii:-it';‘«n_:!ﬁiw:us I:IEHI

I 0k ][ Cancelar ][ Ajuda I

Na pasta General (Geral) aparecerdo algumas opcdes:

Ajuste a opcdo Autosave (Salva automatico) para o numero 10. Isto
significa que o programa efetuar4 uma copia de seguranca do seu arquivo de
trabalho a cada 10 minutos.

Na opcdo Part Units (Unidade de desenho da peca) escolha
Milimetres (milimetros).

E possivel também na caixa de didlogo Preferences alterar dados de
tolerancias, arquivos de importacdo, detalhes de desenho, bibliotecas,
selegéo entre outros.
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2.4.Configurando as Tool bars

Dependendo do tipo de trabalho a ser realizado, algumas ferramentas de
desenho podem ser mais utilizadas do que outras. O programa permite
efetuar certas customizacdes, de modo a facilitar o trabalho do usuario.

Para acionar a caixa de dialogo de customizacéo, clique com o botédo
direito do mouse sobre qualquer barra de ferramentas, e escolha a caixa
planilha Configuration (Configuracdo):

Configurations Appearance .Elpticuns
Commands |  Teobars | Teols | Keyboad | Menu

Categaries: Commands:

Fl: PN M ~
'Edit R

Yiew _"’ Open...

G i

Sjﬁ;nceery B Open Autozave

Fiotary i Part

Dirmenziaon

Taaling = Salid

Move

Turk Cucl & STL

| s v |
Description:
@

A configuracdo standart (padrdo) € a configuragcdo sugerida pelo
fabricante do programa. Selecione a configuracdo standart, e em seguida
clique sobre o botdo Load (carregar). Para finalizar o processo clique em OK.

Normalmente esta configuracdo padrdo é acionada quando O usuério
desativa algum botdo ou suprime a exibicdo de algum icone do programa, o
que pode acabar dificultando seu trabalho.
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2.5.Desenhando no plano ZX

Um dos comandos mais comuns para desenho é o comando line (linha),
gque pode ser acessado pelo menu :

Geometry - Line (Linha)

| General
Falyline [ 1 Horizontal
[ ]ertical [ ] Orthogonal

[] Tangent Ta Paint []Tangent Ta Tangent

To# Co-Ordinate :ér:lnne; v

ToY Co-Ordinate §.<N|:|ne> v: Length

M ame o)

[ 0k, H Cancelar H Ajuda

Selecione o caixa Polyline (Linha mdaltipla).
Acione o botdo OK.

Observe que no canto inferior esquerdo da tela, o programa solicita 0 que é
necessario para efetuar a operacao :

Stark poink of line

Start point of line (Digite o ponto inicial da linha)

Para tracar uma linha na tela é necessario que sejam indicados dois
pontos: Um ponto de inicio e um ponto de final da linha.

Escolha o ponto inicial utilizando o mouse:
Para isto basta clique simples na CPL ou em outro ponto
desejado.

Observe que no canto inferior esquerdo da tela, o programa solicita
novamente o que é necessario para efetuar a operacgao :

End point of line (Digite o ponto final da linha)
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Para indicar o ponto final da linha, basta clique simples no ponto
desejado, ou pressione a tecla X, para abrir a caixa de dialogo solicitando:

Enter Co-ordinates
(Entrada de coordenadas)

A tela Enter Co-ordinates
apresenta uma série de
opcOes para especificar o
ponto final do elemento que
esta sendo desenhado.

Enter Co-ordinates E]
Command | =10
# Absolute W fies

CFL
b Absolute W ®©

Wwhorld
z Absolute  w i

Co-ordinate System
(¥) Cartesian () Palar ) Angular

Falar Angular

[ aE. l [ Cortinue ] [ Cancel ]

Porém para facilitar a entrada de pontos basta acionar o botéo
<< More (Mais). Neste caso surge a tela de entrada de coordenadas.

Enter Co-ordinates

Comend [ |
[ (] l [ Continue ] [ Cancel ]

Utilizando o comando polyline selecione com o0 mouse a CPL como
ponto inicial e em seguida entre com a seguinte sequéncia de coordenadas :

X12.8 20
X13.8 Z-0.5
Z-19

X20.8
X21.8 Z-19.5
Z-35

X33

X34 Z-35.5
Z-49.5

X33 Z-50
X0

Conclua a sequéncia pressionando Enter — duas vezes. O programa
deve indicar no canto esquerdo inferior Ready (Pronto).
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Apoés completar a sequéncia, o perfil desenhado devera ficar da seguinte
forma :

—

|

E possivel selecionar certos tipos especificos de linhas através da caixa
de didlogo Line. Ou diretamente através dos botdes da barra de ferramentas
Line (linha):

LN N A

Da esquerda para direita :

Single Line (Linha simples) — Cria linhas simples no desenho
Horizontal Line  (Linha horizontal) — Cria linhas horizontais no desenho
Vertical Line (Linha vertical) — Cria linhas verticais no desenho
Polyline (Linha multipla) — Cria linhas multiplas no desenho
Line Dialog (Caixa de didlogo de linha) — Abre a caixa de dialogo

para construcao de linhas

Através dos botBes da barra de ferramentas Design (Desenho):

Design - X
A ORAN=RAES

Da esquerda para direita :

Polyline (Linha multipla) — Cria linhas mdltiplas no desenho

Radius Arc (Arco com raio) — Cria cicunferéncias completas,
bastando indicar o ponto de centro e raio

Rectangle (Retangulo) — Cria retngulo, basta informar coordenadas
correspondente aos seus cantos

Point (Ponto) — Marca pontos no desenho

Auto-Stock Criacao automética da peca
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Criando o material da peca

Apoés desenhar o perfil da peca, é necessario informar qual € o tamanho
do material do qual sera feita a peca. Para criar o material, use o menu:

Geometry - Stock / Fixture (Material da peca / Fixacao)
x|
General
Automatic Stock
Shape -.Eylinder b
Calour [E w | Layer ;.Stn:n::k v
Stle =~
Biow Offset
Cylinder Offzet
Start Extenzion |:||:| End Estension |:||:|
Fiadiuz Extension |00
I k. I I Cancelar I [ Ajuda I

A caixa de selecdo Stock (Material da peca) permite as seguintes
escolhas :

Cylinder (Cilindro reto)

Cylinder Offset (Medidas do cilindro)

Start Extension (Sobremetal na face esquerda)
End Extension (Sobremetal na face direita)
Radius Extension (Sobremetal no raio)

Neste caso, o programa cria um cilindro reto sobre o perfil da peca com os
valores de sobremetal indicados na caixa Cylinder Offset (Medidas do
cilindro).

Box Offset (Caixa)

Na escolha Box Offset (Caixa) o programa cria um paralelepipedo reto
com medidas minima e maxima para cada eixo (X, Y e Z), obedecendo a
posicao escolhida para o plano de trabalho (CPL).
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2.6.Comandos de visualizagéo

E possivel rotacionar a peca a qualquer momento da modelagem. Para
isto, apenas arraste 0 mouse pressionando o botdo direito. Observe que a
vista da modelagem passa para Dynamic (Vista dinamica).

Para retornar a vista Turn (Torneamento) clique simples sobre a palavra
Dynamic, e escolha a vista Turn

L

Arrastando o0 mouse com o0 botdo do meio pressionado, € possivel a
funcdo Pan (Panoramico), que desloca a peca na tela mantendo a escala.

E possivel executar outros comandos de exibicdo do desenho através da
barra de ferramentas Display (Exibi¢ao):

% 0SS | %y H

2.7.Passando para o modo de manufatura

Para se efetuar a simulacdo da usinagem da peca é preciso mudar o
ambiente de trabalho do programa. Isto é feito através do menu:

Options > Manufacture (Modo de manufatura)

%
Acionando CTRL+M, ou através do botao: | J
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O programa solicita a sequéncia de usinagem a ser criada. Na mesma
peca é possivel criar mais de uma sequéncia para fabricacdo da peca.

Machining Sequence g

General | Job Deta | Lathe Setup|
Sequence Mame | Discipline :Tum |
Maching T ool l dcybss-ger » | Initial CPL . Top biet
Dratum Type
ok l [ Cancelar ] l Ajuda

Escolha a pasta General (Geral) e descreva 0s seguintes itens :

Sequence Name (Nome da sequiéncia da usinagem) — Pode ser o nome
da operacéo a ser realizada, ou conjunto de operacoes.

Job Name (Nome do trabalho) — Nome do arquivo que ird conter os
dados da folha de processo gerada pelo programa.
Normalmente neste campo associa-se 0 numero do
desenho da peca.

Discipline (Processe de fabricacdo) — Esta relacionada ao tipo de
maquina que ira executar o trabalho.
Machine Tool (Maquina ferramenta) — Esta relacionada com o comando

CNC utilizado na maquina escolhida. O mesmo programa
CAM pode gerar diferentes arquivos CNC para diferentes
comandos, bastando escolher o pés processador
adequado ao tipo de comando da maquina.

Initial CPL (Plano de trabalho inicial) — Indica qual é o plano de
trabalho a ser utilizado inicialmente pelo programa.
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2.8.Selecionando ferramentas para usinagem

Para se efetuar a usinagem € preciso inicialmente escolher uma
ferramenta. Isto é possivel através do menu:

Tooling =2 Tool store (Banco de dados de ferramentas)
Ou através do botéao: E

O programa abre um banco de dados de ferramentas onde é possivel
escolher graficamente e através da codificacdo ISO a ferramenta mais
apropriada para execuc¢éo da usinagem.

wg geCAM - [clarquives de programasiedgecamicamiistoreMstore lﬂ@@]

2 il ﬁ Turn B Hole | Tools
: = : | Create...
Symbal Moze

¢ Tool Descrption
: @ CSKPL-2020-K12 General Back GE1015
ﬁ CSKPL-2020-12 General Back GC4015
[ a C5KPR-2020-12 General Back GC1015 - Square
[ @ CSKPR-2020-K12 General Back GCA015 - Square

S - Square
5
5

[ 5

| a CSEPR-2020-k12 General Turn GCA015 5 - Sguare
C
C
C
]

- Square

“ E12R-5CFCLO3-R Gen Boring only GC1015 - 80 Rhambic:
| @ E12R-5CFCRO3-R Gen Boring only - GC1015 - 80 Rhombic
* E12R-5CFCRO3-R Gen Boring only - GC4015 - 80 Rhombic
@' L136.13-0016-07 Finish Bore - GC1015 - BB Rhombic

@ L 166, 4.KF-16-16 1.00mm Pitch - GC 1020 Filtering
| {8 | 166 4FGZ-3225-16 1.25mm Ext. - GC 1020

o | 4G 151.22-25R-20 Groove - GC225 b

100k ]
| | > ':
@‘ p‘@‘ @(w\ wi@‘ ﬁ‘ [ inches | [ Millimetres |

[ Cancel H Help H Print ]

E possivel escolher dentro de trés grupos de ferramentas:

Mill  (Fresa) — Ferramentas utilizadas para operacdes de fresagem.
Turn (Torno) — Ferramentas utilizadas para operacgdes de torneamento.
Hole (Furo) — Ferramentas utilizadas para furacéo tanto em tornos como em

kel L LR

Também é possivel selecionar sub grupos por tipo de operacdo de
usinagem utilizando os botes acima. Ao manter o cursor sobre o botao (sem
acionar o mouse) o programa indica a sua funcdo através de uma caixa de
texto que flutua sobre o botdo por um tempo.
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E possivel também visualizar e modificar detalhes das ferramentas.
Para isto, no item filters na caixa de dialogo acima, basta clicar em tools,

assim abrira a seguinte caixa de dialogo:

Job

| [:] Include fAvailable Tools

|
|
hd aterial | | [:] Include <Any: b aterial
|
|

T ool Description

Comment | _&J Spindle Direction

MNotes | )__{__J @ E}i
kinimum b amimim

Cut Depth | | | | Style
Roughing # Finizhing |,-‘.‘-.II w |
‘ Azsignment
Location faruc2y top b
| |

Allocated
] I navailable

—

Show i lizt | anly visible toolz b |

[ k. H Canicel ] Apply

O programa permite diversas montagens e configuracbes de
ferramentas. E muito importante que este banco de dados existente no
programa represente as ferramentas existentes na empresa, pois desta
maneira o trabalho do programador estara sujeito a menos erros durante a
programacao. Porém, se na descricdo da ferramenta estiver a sua
codificagdo 1SO correspondente, ndo € recomendavel fazer alteracdes no
banco de dados de ferramentas, pois o codigo ISO ja fornece as informacdes

necessarias das ferramentas.

Para utilizacdo de ferramentas especiais, recomenda-se a criacéo de
novos registros no banco de dados de ferramentas, que possam representar
as ferramentas existentes na empresa.
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2.9.Criando ciclos de usinagem

Apl6s a escolha da ferramenta, o préximo passo € a indicacdo das
operacoes de usinagem a serem realizadas.

2.9.1. Faceamento

Normalmente para pecas de torno, a primeira operacdo a ser executada é
o faceamento. Isto se consegue através do menu:

Cycles - Straight Turning (Faceamento)

Ou através do botéo:ﬁ

Straight Turning

| Gereral
Feedrate [mmdrev] m Speed [RPM] ;545
Cut Incremnent 5.0
[ Mo Stepover Adjustment Link Type Hapld v.'
[] Canned Cycle [ Digitize Start N |
[ 5afe Approach []Rough Cuts Only
Feature Name . w | CutDiection | cDigitizes .
Chipbreak. amount . —
[ k. ] [ Cancelar ] [ Ajuda

Na pasta General (Geral), aparecerao as seguintes opc¢des :

Feedrate (Avanco) — Valor do avango em mm/min

Speed (Velocidade) — Valor da velocidade de corte em m/min

Cut Increment (Profundidade de corte) — Valor da profundidade de corte
em mm

No Stepover (Sem Stepover de ajuste) — O valor da profundidade de
corte é fixo, respeitando a posicao final da usinagem

Link Type (Tipo da ligagao) — Indica o tipo do movimento entre 0s
passes de faceamento.

Canned Cycle (Ciclo de desbaste) — Gera o programa CNC com ciclo de
desbaste

Digitise Start (Digite ponto inicial) — Solicita o ponto inicial do
faceamento

Safe Approach (Aproximacgao Segura) — Cria um ponto de aproximacao

fora do perfil da peca, dependendo da posicao anterior
da ferramenta
Selecione as opcodes desejadas e clique em OK.
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Surge a seguinte tela:

Observe que no canto inferior esquerdo da tela, o programa solicita o que é
necessario para efetuar a operacao :

e 17 | A —
[ ] Coioue | Coet | ——— S

Digitise cycle start position  (Digite o ponto de inicio do ciclo de faceamento)

lDigilise cycle start position

Neste caso, € possivel escolher um ponto préximo do perfil da peca
com clique simples na posicao desejada.

Ou entdo, pressione a tecla X e digite no teclado os valores de
coordenadas em X e Z do ponto de aproximacédo da ferramenta:

Enter Co-ordinates

Command K#DEE |

[ [H] 8 ] [ Caontinue ] I LCancel I

Em seguida o programa solicita o ponto de destino, quer dizer o ponto
final do faceamento:

Destination point  (Digite o ponto final do ciclo de faceamento)

Enter Co-ordinates

Command :K'I Z0

[ ok l [ Continue ] [ LCancel ]

Na usinagem com torno CNC, € comum efetuar o faceamento da
periferia da peca para o centro. A coordenada do ponto final é X-1, devido ao
raio da ponta da ferramenta.
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Finalmente, digite a direcéo do corte.

Digitise Drive / Cut direction (Digite o percurso ou direcdo do corte)

i

A seta maior indica o sentido de desolcamento, e a seta menor indica
a direcao da profundidade de corte.

Para mudar a direcdo de corte, basta clicar em qualquer posicéo
proxima da seta, que 0 programa apresenta a nova escolha. Quando a
direcdo de corte estiver correta, pressione Enter para concluir.

2.9.2. Desbaste

Para se fazer usinagens em desbaste, o programa oferece a possibilidade
de utilizacdo de ciclos de desbaste. Isto se consegue através do menu:

Cycles = Rough Turning (Torneamento em desbaste)

Ou através do botao: ﬂ

General | Cycle Contral | Advanced

Feedrate [mm/rey] :P'.S | Speed [RPM) 54.5

Cut Incrament :_5.|:I

Deagression '_ | ¥ Offset _ .
Y Offzet . Firish At Cycle start v
] Canned Cycle ] Rough Cuts Only

[] Safe Approach Cut Direction | <Digitize> |

Feature Mame | A
Frofile Extenzion

Start |<Digitise> % | End <Digitize>

(] H Cancelar H Ajuda
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Na pasta General (Geral), aparecerao as seguintes opcoes :
Feedrate (Avanco) — Valor do avanco em mm/min
Speed (Velocidade) — Valor da velocidade de corte em m/min
Cut Increment (Profundidade de corte) — Valor da profundidade de corte
Degression (Degressao) — Valor da reducao da profundidade de corte
Z Offset (Offset em Z) — Valor da material deixado para
acabamento no eixo Z
X Offset (Offset em X) — Valor da material deixado para
acabamento no eixo X (em raio)
Canned Cycle (Ciclo de desbaste) — Gera o programa CNC com ciclo de
desbaste

Rough Cuts Only  (Apenas corte de desbaste) — O programa calcula
apenas movimentos paralelos ao eixo Z, sem passe de
pré-acabamento.

Safe Approach (Aproximacgao Segura) — Cria um ponto de aproximacao
fora do perfil da peca, dependendo da posicao anterior
da ferramenta

Selecione as opcodes desejadas e clique em OK.

Observe que no canto inferior esquerdo da tela, o programa solicita o
gue € necessario para efetuar a operacao:

|
|Line#ﬁrc#[ﬁnntinunus#ﬁrn:uup az prafile

Line/Arc/Continuos/Group as profile (Selecione o perfil de desbaste)

Ao selecionar os elementos do perfil a ser desbastado, a cor do
elemento modifica na tela.

O perfil pode ser composto de varios elementos do desenho. Para
efetuar a selecdo de varios elementos cligue uma vez sobre cada elemento.
Para desetivar a selecéo, cligue novamente sobre o elemento selecionado.

Também é possivel escolher o perfil do desbaste abrindo janelas de
selecdo. Isto é feito arrastando 0 mouse com o botdo esquerdo pressionado.
Janelas abertas da direita para esquerda selecionam os elementos que
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estiverem totalmente contidos na janela. Janelas abertas da esquerda para a
direita selecionam todos os elementos que estiverem na janela, mesmo que
parcialmente.

Para concluir a selecao, pressione Enter .

Para cancelar a operacdo de desbaste pressione ESC.

CUIDADO para néo selecionar o Stock (Material da peca)
Em seguida, escolha os limites da usinagem:

Observe gque no canto inferior esquerdo da tela, o programa solicita o
que é necessario para efetuar a operacao:

Select location for chain end (Selecione as posic¢des limite do perfil)

|SEIEn:t location for chain end

Surgirdo duas pequenas estrelas que indicam o inicio e final do perfil
selecionado. Com um clique simples na estrelas da direita, é possivel
deslocar o ponto de inicio do desbaste, bastando mover o mouse para a

esquerda. Um novo clique estabelece a nova posi¢éo de inicio do desbaste.

i
i
‘Pﬁ —

De mesma forma é possivel deslocar a estrela da esquerda, que indica
a posicao final do perfil a ser debastado. Observe que durante 0 movimento
do mouse a estrela se desloca sobre o perfil selecionado.

Para concluir a selecao, pressione Enter .

Para cancelar a operacéo de desbaste pressione ESC.

A mesma sequéncia de comandos serve tanto para desbaste de perfis
externos, quanto para desbaste de perfis internos (furos).
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Em seguida o programa solicita o ponto inicio do ciclo, quer dizer o
ponto de aproximacéo do desbaste:

Digitise cycle start position (Digite o ponto inicial do ciclo de desbaste)

Enter Co-ordinates

Command |X40Z2

[ ok l [ Continie I [ Cancel ]

Finalmente, digite a direcéo do corte.

Digitise Drive / Cut direction (Digite o percurso ou direcdo do corte)

A seta maior indica o sentido de desolcamento, e a seta menor indica
a direcao da profundidade de corte.

Para mudar a direcdo de corte, basta clicar em qualquer posicéo
proxima da seta, que o0 programa apresenta a nova escolha. Quando a
direcédo de corte estiver correta, pressione Enter para concluir.

2.9.3. Acabamento

A operacdo de acabamento remove o material restante da operacao de
desbaste. Isto se consegue através do menu:

Cycles = Finish Turning (Torneamento em acabamento)

Ou através do botao: ﬂ
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Finish Turning @
G.E”ETEJI i_-l-_ee;u:l __..i'-.u:lvanceu:.l:
Feedrate [mmdrev] E|2 : Speed [RPM) -225
Z Offset | ROt -
[] Canred Cycle [] Digitize Start
[]5afe Approach Feature Mame v_
[ ¥, ] [ Cancelar ] I Ajuda ]
Na pasta General (Geral), aparecerao as seguintes opcoes :
Feedrate (Avango) — Valor do avango em mm/min
Speed (Velocidade) — Valor da velocidade de corte em m/min
Z Offset (Offset em Z) — Valor da material deixado para
X Offset (Offset em X) — Valor da material deixado para
acabamento no eixo X (em raio)
Digitise Start (Digite ponto inicial) — Solicita o ponto inicial da usinagem
Safe Approach (Aproximacao Segura) — Tipo de aproximagao
Feature Name (Caracteristica) — Para acabamentos especiais

Selecione as opcdes desejadas e clique em OK.
O programa ira solicitar para selecionar o perfil a ser usinado.
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2.9.4. Usinagem de canais

A usinagem em desbaste de canais se consegue atraveés do menu:

Cycles - Rough Groove (Desbaste de canal)

Ou através do botao: i’—'r

Rough Grooving

General _.-'f-.dvanced_

Cycle Type Firish At [Cpcle start B
%) Sequential = ==
) Centre Sequential [[] Safe Approach
() Centre Altemnate Feedrate [mmiev] 0.2

Speed [FPM) 225
% Stepaover ;5|:| £ Offzet
# Offset Feature Marme 2|
Dhwell Bevalutions
Prafile Estenzion
Start <Digiise> + | End <Digitiss> |
[ k. l [ Cancelar I l Ajuda ]

Na pasta General

Cycle Type
Finish At

Safe Approach
Feedrate
Speed

Cut Increment
Z Offset

X Offset

Feature Name
Dwell Revolutions

Profile extension

Start
End

(Geral), aparecerao as seguintes opc¢oes :

(Tipo do ciclo) — Estratégia de usinagem do canal
(Acabe em) — Ponto final de usinagem

(Aproximacao Segura) — Tipo de aproximagao

(Avanco) — Valor do avango em mm/min

(Velocidade) — Valor da velocidade de corte em m/min
(Profundidade de corte) — Valor da profundidade de corte

(Offset em Z) — Valor da material deixado para
acabamento no eixo Z
(Offset em X) — Valor da material deixado para

acabamento no eixo X (em raio)

(Caracteristica) — Para canais especiais

(Rotacdo em espera) — Numero de rotacbes em que a
ferramenta fica parada no fundo do canal

(Extenséao do perfil) — Indica a posicdo de inicio e término
da usinagem em relacéo ao perfil selecionado

(Inicio) — Distancia inicial para usinagem

(Fim) — Distancia final para usinagem

Selecione as opcdes desejadas e clique em OK.
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A usinagem em acabamento de canais se consegue através do menu:

Cycles = Finish Groove (Acabamento de canal)

Ou através do botao: E

Finish Grooving

General | _.-'f-.dvan-:eu:l _

Feedrate [mnmdrev]
£ Offset

Finizh At

Feature Name
Prafile Estenszion

Stark

E_I,lu:le start [ [ ] Digitize: Start

[ <D

| Speed RPM] 225

| % Oifsat

[15afe &pproach

=

qitizes v End :<Digitise> v-

0k, H Cancelar H Ajuda ]

Na pasta General (Geral), aparecerao as seguintes opcoes :

Feedrate
Speed
Z Offset

X Offset

Finish At
Digitise Start
Safe Approach
Feature Name
Profile extension

Start
End

(Avanco) — Valor do avanco em mm/min
(Velocidade) — Valor da velocidade de corte em m/min

(Offset em Z) — Valor da material deixado para
acabamento no eixo Z
(Offset em X) — Valor da material deixado para

acabamento no eixo X (em raio)

(Acabe em) — Ponto final de usinagem

(Digite ponto inicial) — Solicita o ponto inicial da usinagem
(Aproximacao Segura) — Tipo de aproximacgao
(Caracteristica) — Para canais especiais

(Extenséao do perfil) — Indica a posi¢ao de inicio e término
da usinagem em relacéo ao perfil selecionado

(Inicio) — Distancia inicial para usinagem

(Fim) — Distancia final para usinagem

Selecione as opcdes desejadas e clique em OK.
O programa ira solicitar para selecionar o perfil a ser usinado.
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2.10. Simulacéo de usinagem

As operacbes de usinagem podem ser simuladas. Isto se consegue
através do menu:

View = Simulate Machining (Simulador de usinagem)

v
Ou através do botao: i

A simulacado ajuda a verificar a sequéncia de operacdes programadas,
bem como oferece um resumo das operacdes, mensagens de alerta sobre
possiveis erros de programacao.

(==l

Speed Contral

& [

E possivel controlar a velocidade de simulacio. Basta arrastar o botdo
de controle Speed Control (Controle de velocidade).

- %-® B4 -[2-5-]
Os comandos de visualizacdo permitem alterar o modo de exibi¢cdo da

peca, da ferramenta e das trajetorias de usinagem. Estes comandos podem
ser mudados durante a simulacédo de usinagem.
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2.11. Criando operacdes de usinagem
O programa também permite o agrupamento de operacoes.
2.11.1. Turn operation (Operacéo de torneamento)

Para operacdes de torneamento, sdo necessarias algumas informacdes
gerais:

General | Roughing Finishin__g

Tool Orientation Cut Direction

% Tum & Tum

{3 Back Tum {1 Face

) Bore

" Back Bare Spindle Direction

- (% Fonward
[]css () Reverse
[] Canned Cycle

[ ] Prevent Undercuts
Frofile Estengion

Start | End

I (] H Cancelar H Ajuda I

Na pasta General (Geral), aparecerdo as seguintes opcoes :

Tool Orientation (Orientacéo da ferramenta) — Indica o lado do trabalho

Cut Direction (Direcao de corte) — Torneamento ou faceamento

Spindle Direction  (Direcédo de giro) — Normal ou invertida

CSS (Degresséao) — Valor da reducao da profundidade de corte

Canned Cycle (Ciclo de desbaste) — Utiliza as funcbes G para ciclo de
desbaste

Prevent Undercuts (Evitar cortes pequenos) — Previne

Profile Extension  (Extensdo do perfil) — Regula a aproximacéo e saida da
ferramenta de corte em relacéo ao perfil a ser usinado

Start (Inicio) — Valor numérico da aproximacao do perfil

End (Fim) — Valor numérico da saida da ferramenta do perfil

Selecione as opc¢des desejadas e passe a pasta Roughing (Desbaste)
da caixa Turn Operation (Operacao de torneamento).

Prof. Claudimir José Rebeyka/ Prof. Ricardo Adriano dos Santos 26



PROGRAMACAO CNC

¢

ENSITEC

Turn Operation

| General | Reughing | Firishing|

Strategy
"3 Mo Roughing
{33 Rough Tum

Cut Increment 5 _
Z Offset | Offset
Taoaling
ToolStore
Feedrate 0z . Speed 5225
Position ' ¢ Moze Radiug |:|4

Sumbal | C=a0a BRI v Inzcribed Circle E|5

Side dngle | 100

[] Fough Cuts Orly
[] Pathtrace Compensation

[

2k, H Cancelar ][ Ajuda ]

Na pasta Roughing (Desbaste), apareceréo as seguintes opgoes :

Strategy
Rough Cuts Only

Pathtrace
Compensation
Cut Increment
Z Offset

X Offset

Tooling
ToolStore
Feedrate
Speed
Position

Nose Radius
Symbol
Edge Lenght
Side Angle

(Estratégia de usinagem) — Indica com ou sem desbaste
(Apenas corte de desbaste) — O programa calcula
apenas movimentos paralelos ao eixo Z, sem passe de
pré-acabamento.

(Compensacéo de corte) — Compensa o perfil de corte
(Profundidade de corte) — Valor da profundidade de corte

(Offset em Z) — Valor da material deixado para
acabamento na direcao do eixo Z
(Offset em X) — Valor da material deixado para

acabamento na direcao do eixo X (em raio)
(Ferramental) — Escolha a ferramenta para o desbaste
(Ferramental) — Escolha com o botéo Find... (Encontre)
(Avanco) — Valor do avanco em mm/min

(Velocidade) — Valor da velocidade de corte em m/min
(Posicdo) — Escolha a posicdo da ferramenta no
magazine — valor numerico

(Raio da ponta) — Valor do raio da ponta da ferramenta
(Simbolo) —

(Comprimento da aresta da ferramenta) — Valor numérico
(Angulo de entrada) — Valor numérico

Selecione as opcdes desejadas e passe a pasta Finishing
(Acabamento) da caixa Turn Operation (Operacéo de torneamento).
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Turn Operation @
| General | Flln:nug_.hing Finizhing |
Strategy Compenzation
{7 No Finizhing %) None
%) Finizh Tumn 7 Left
O Right
Z Offset ) Pathtrace
= Offzet Back OFf
Tooling
ToolStaore
Feedrate nz Speed 225
Position # | Moze Radius 04
Symbol = 80e Rt v | IrscrbedCicle |05
Side Angle 100 | ] Uze Roughing Taoal
[ k. J [ Cancelar ] I Ajuda ]

Na pasta Finishing (Acabamento), apareceréo as seguintes opcoes :

Strategy

Compensation
Cut Increment
Z Offset

X Offset
Back Off

Tooling
ToolStore
Feedrate
Speed
Position

Nose Radius
Symbol
Edge Lenght
Side Angle

(Estratégia de usinagem) - Indica com ou sem
acabamento

(Compensacéo de corte) — Usa G41 ou G42
(Profundidade de corte) — Valor da profundidade de corte
(Offset em Z) — Valor da material deixado para
acabamento na direcao do eixo Z

(Offset em X) — Valor da material
acabamento na direcao do eixo X (em raio)
(Recuo) — Valor do recuo proximo da peca, antes de ir
para o ponto de troca de ferramenta

(Ferramental) — Escolha a ferramenta para o desbaste
(Ferramental) — Escolha com o botéao Find... (Encontre)
(Avanco) — Valor do avango em mm/min

(Velocidade) — Valor da velocidade de corte em m/min
(Posicdo) — Escolha a posicdo da ferramenta no
magazine — valor numerico

(Raio da ponta) — Valor do raio da ponta da ferramenta
(Simbolo) —

(Comprimento da aresta da ferramenta) — Valor numérico
(Angulo de entrada) — Valor numérico

deixado para

Use Roughing Tool (Use a ferramenta de desbaste) — Seleciona a mesma

ferramenta utilzada para desbaste.

Selecione as opcdes desejadas e clique OK.
O programa vai solicitar para selecionar o perfil a ser torneado.
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2.11.2. Hole operation (Operacéo de furacao)

Para operacoes de furacdo, sdo necessarias algumas informacdes gerais:

| » Operation &3’
General Eentre.-"Spu:ut__ Preparation I Roughing I Finishing_

Clearance . a0
Retract

Lewvel ' 0.0

Termination
%) Blind
{3 Through

Spindle Direction
(%) Forward
) Reverse

[ k. H Cancelar H Ajuda ]

Na pasta General (Geral), aparecerao as seguintes opc¢oes :

Clearance (Aproximacao) — Indica a altura do plano de aproximacgao
Retract (Retracéo) — Indica a altura de recuo da ferramenta

Level (Plano) — Indica a posicao da face da furacao
Termination (Tipo do furo) — Determina se o furo é Blind (cego) ou

Through (furo passante)

Spindle Direction  (Sentido de giro da ferramenta) — Para ferramentas
direitas use Forward (Sentido horario), para ferramentas
esquerdas use Reverse (Sentido anti-horario)

Selecione as opcdes desejadas e passe a pasta Centre/Spot (Furo de
centro) da caixa Hole Operation (Operacéao de furacao).
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Hole Operation

Strategy

) Mone
% Centre Dril
2 Spat Dl

| ~Tonling
ToolStore
Plunge Feed |15

Position

| Generalz Centre/Spat '_F're!:ufaraticun ___I.:EDL_Jghin_g I F.i.nisﬁi_r?é__;

Depth

[

| Speed 200
| Diameter EIE
[ F, ] [ Cancelar ] I Ajuda ]

Na pasta Centre/Spot (Furo de centro), apareceréo as seguintes opcoes :

Strategy

Depth
Tooling
ToolStore
Plunge Feed
Speed
Position

Diameter

(Estratégia) — Indica o tipo da usinagem
None (sem furo de centro)

Centre Drill (Furo de centro) e

Spot Drill (Marcador)

(Profundidade) — Indica a profundidade do furo
(Ferramental) — Escolha a ferramenta para o desbaste
(Ferramental) — Escolha com o botédo Find... (Encontre)
(Avanco de furacdo) — Valor do avango em mm/min
(Velocidade) — Valor da velocidade de corte em m/min
(Posicdo) — Escolha a posicdo da ferramenta no
magazine — valor numerico

(Didametro) — Indica o diametro da ferramenta
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Hole Operation @

Strategy

() Countersink,
i) Courterbore

Toaoling

_ General I Eentre.-"S_pu:ut_f Freparation ,_Fh:uu_g_h_ing I Finishing_

i) Mo Preparation

l k. H Cancelar ][ Ajuda ]

Na pasta Preparation (Preparacao), aparecerao as seguintes opc¢oes :

Strategy

Depth
Diameter
Angle

After Roughing
Tooling
ToolStore
Plunge Feed
Speed
Position

Diameter

(Estratégia) — Indica o tipo da usinagem
No Preparation (sem preparacéo),
Counter Sink (Furo com chanfro) e
Counter Bore (Furo com rebaixo)

(Profundidade) — Indica a profundidade do rebaixo
(Diametro) — Indica o diametro do chanfro

(Angulo) — Indica o angulo do chanfro

(Apo6s o desbaste) — Indica a ordem de operacdes
(Ferramental) — Escolha a ferramenta para o desbaste
(Ferramental) — Escolha com o botédo Find... (Encontre)
(Avanco de furacdo) — Valor do avango em mm/min
(Velocidade) — Valor da velocidade de corte em m/min
(Posicdo) — Escolha a posicdo da ferramenta no
magazine — valor numerico

(Diametro) — Indica o diametro da ferramenta
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Strategy
{7 Mo Roughing
) Drill
") Chipbreak
) Peck, Dl

Tooling

ToolStore
Flunge Feed 15

Position

|

Gereral Eentrex’Si:u:ut_ Preparation R oughing Finishiﬁ_g

Depth [Full Diameter]

Chwell Time

[

| Spes m
:. Diarneter 05
[ (] ] [ Cancelar ] [ Ajuda ]

Na pasta Roughing (Desbaste), aparecerédo as seguintes opcoes :

Strategy

Depth

Dwell Time
Cut Increment
Safe Distance
Tooling
ToolStore
Plunge Feed
Speed

Position

Diameter

(Estratégia) — Indica o tipo da usinagem —

No Roughing (sem desbaste),

Drill (Furo simples),

Chipbreak (Furo com quebra e remocéo do cavaco) e
Peck Drill (Furo com quebra cavaco)

(Profundidade) — Indica a profundidade do furo no
diametro da ferrameta

(Tempo de espera) — Indica o tempo para quebra do
cavaco

(Incremento de corte) — Indica a quantidade de material a
ser removida em cada penetracéo da ferramenta
(Distancia de seguranca) — Indica a distancia de
aproximacéo da ferramenta durante a furacao
(Ferramental) — Escolha a ferramenta para o desbaste
(Ferramental) — Escolha com o botéo Find... (Encontre)
(Avanco de furacdo) — Valor do avanco em mm/min
(Velocidade) — Valor da velocidade de corte em m/min
(Posicdo) — Escolha a posicdo da ferramenta no
magazine — valor numerico

(Diametro) — Indica o diametro da ferramenta
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Hole Operation E

Strateqy
% Mo Firighing
(O Tap
) Ream
) Bore

Taoaling

| General | Centre/Spot | Preparation | Fioughing | Finishing |

| Units lInches  w |

[ 0k, H Cancelar H Ajuda ]

Na pasta Finishing (Acabamento), aparecerdo as seguintes opcoes :

Strategy

Full Depth
Depth

Dwell Time
Hand of Thread
Pitch

Tooling
ToolStore
Plunge Feed
Speed

Position

Diameter

(Estratégia) — Indica o tipo da usinagem —

No Finishing (sem acabamento),

Tap (Furo com rosca feita com macho),

Ream (Furo com acabamento feito por alargador) e

Bore (Furo com acabamento feito por barra de mandrilar)

(Profundidade total) — Indica a profundidade do furo igual
a profundidade do furo de desbaste

(Profundidade) — Indica a profundidade do furo no
didmetro da ferrameta

(Tempo de espera) — Indica o tempo para quebra do
cavaco

(Sentido da rosca) — Indica se a rosca é Right (Diretita)
ou Left (Esquerda)

(Passo da rosca) — Indica o valor numérico do passo da
rosca

(Ferramental) — Escolha a ferramenta para o desbaste
(Ferramental) — Escolha com o botéo Find... (Encontre)
(Avanco de furacdo) — Valor do avanco em mm/min
(Velocidade) — Valor da velocidade de corte em m/min
(Posicdo) — Escolha a posicdo da ferramenta no
magazine — valor numeérico

(Diametro) — Indica o diametro da ferramenta
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2.12. Gerando o programa CNC

Para se criar o programa CNC, o cédigo que vai para a maquina é
necessario processar as informacbes graficas do CAM. Isto é possivel
através do menu:

File > Generate Code (Geracao do programa CNC)

ST
Ou através do botdo: =dd

Generate CHC Code g

General

[ 1Use Part Name

CHC Mame :T.I.:Irr'lE!al'l'lE!r.'IEDS.;

Job Mame {CHCO0033 . Browse. ..
Operation Mames Open Editar
POl

M ame -::; Mones

I_ k. ][ Cancelar H Ajuda ]

Na pasta General (Geral), aparecerao as seguintes opc¢oes :

CNC Name (Nome do programa) — Indica o nome do arquivo que ira
conter o codigo CNC.
Job Name (Nome do trabalho) — Nome do arquivo que ira conter 0s

dados da folha de processo gerada pelo programa.
Normalmente neste campo associa-se 0 numero do
desenho da peca.

PDI Name (Nome do PDI) — Arquivo a ser executado

Operation Names (Nomes das operagbes) — Solicita os comentarios a
serem incluidos no programa

Open Editor (Abre o editor) — Abre o arquivo CNC no fim do processo.
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Code Generator

Programmer's Mame |

k. | Cancel

Digite o Nome do programador, clique OK

Code Generator

Enter program [0 number |

k. | Cancel

Digite o numero do programa, cliqgue OK

Code Generator

Program Description ]

0] 4 Cancel

Digite o comentario para aparecer no inicio do programa — normalmente
utiliza-se o niamero do desenho e sua respectiva revisdo. Cliqgue OK.

Lol

D|@|E| Sl :|mle-| ) 2|6

* Turret Ho. : 7 Description : USER DEFINED ZSet : .088 Xset : .0o0@ Hose Radir_

* Turret Ho. : 8 Description : LSASL-183 BSP External Thread {Inch) Z2Set : .888 &5

* Machine Tool : Fanuc "T" Series _J

* Part Hame : inch - 2 axis turning part

* Jequence i |

* Programmed By : RICARDO

= Date - B4/s15/85

= Time : B1:18:88

*

* Total Machining Time {including Toolchange} : 27.132 Hinutes

* Idle Time {including Toolchange) : .868 Hinutes

%

-gam

()

H18 G228 G928 G4B G95

H28 G18 Te1 X98.8 28.0 18.0313 KO.8313

N28 G18 Te2 X6.8 Z0.0 18.0 KA.4375

N48 G18 Te8 %6.0 Z8.0 18.0 K1.8

M58 G189 TO3 XO.8 Z0.8 1-8.08156 KA.0156

H&6GO G189 Ty XA0.0 70.0 18.0 KB.@

H78 G18 TO5 X68.8 70.08 18.0 KB.@

HBB G18 Teé X9.8 Z8.8 1-0.81 Ka.m,

N98 G18 TH7 X0.8 70.0 18.0 KA.5 -
{q »
Ready mom [ loooooor joor

Tela final da programacédo — mostra o progama CNC gera'do'pelo CAM.
2.13. Importando arquivos do CAD

Para efetuar a importacédo de arquivos, basta apontar para o menu:
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File > Open (Abrir arquivo)
Ou através do botdo: ——
m PX
E xaminar: |'r';"’.'basic tuming v| ¢ ¥ @

LY @2 axis kurning park mc using operations
inch - 2 axis kurning part

D =
@Rough and Finish Side Grooving

Documentos
recentes Feé Torneamentas

Fr
L&

Desktop

Meus
documentos
Show Preview

L

]

teu computador
Abrir

H_j)l Mome do arquivo:
Meus locaiz de Arguivos dotipo: | Al Fles 7
EdgeCakd Parts

rede
[

O EdgeCAM reconhece uma série de arquivos gerados em programas do
tipo CAD. Para abrir arquivos que ndo sejam nativos do EdgeCAM, escolha

pela caixa de selecdo Arquivos do tipo: e selecione o tipo do arquivo

I

W
o

’ Cancelar ]

[

desejado.
Em seguida localize o arquivo através da caixa de sele¢do Examinar:

Selecione o arquivo que se deseja abrir e cliqgue sobre o botdo Abrir
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2.13.1. Corrigindo a posicédo do plano de trabalho

FreqUentemente, o projetista que desenvolve o produto com o uso de
programas do tipo CAD, utiliza referenciais apropriados para a funcionalidade
do produto. Porém nem sempre estes referenciais sdo os mais adequados
para a manufatura. Nestes casos € necessario proceder algumas alteragdes
no sistema de coordenadas da peca, corrigindo o plano de trabalho para
possibilitar a criagdo do programa CNC da maneira apropriada para a
fabricacao.

Para corrigir a posicao do plano de trabalho, basta apontar para o menu:
Edit > Transform (Modificacéo)

Ou através do barra de ferramentas:

Qﬁ (/'P-fﬂ_.-f"\ ;El'

D:AClaudimirASIdprthExer11 - EdgeCAM mE R
EileEiew Geomety  Rotary  Dimension  Solids  %erfy  Custom  Options  Help

[E s 2F | [—Eeeomery 3] @0 = % [f8% [fum o0 ]fasm |
|/ pekee d« anraald @aaclorto<ces @mmm

Lay  Dielete CPL

Ma  Entity Data »
Fadiuz

Trim

Chamfer
Continuous
Surtace Eroum

Explode

Tranzform Hdirror

Scale =2 Project
Botat

Slnfase EumE e

; Siale

Tjrim Srface: -
Translate

CPL Transpose

Ciynamic 30.43 Blml =/
I=| Constarit
ﬂ i ! " e ] ><|4-24 B ‘wiorld | REER= |

O A B 17 =
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Os comandos de transformacao mais utilizados sdo os seguintes

T

eneral |

[T Copy [ Fized Origntation

Z Ratatian I # Rotation I
" Raotation I Repeatz I E:
Layer I vI

k. I Cancelar | Ajuda |

A opcédo Rotate (Rotag&o) possibilita rotacionar a peca em qualquer direcao.

Tranzpose [ x| |

Tranzpose Iw.;,zx vI
] 4 I Cancelar | Ajuda

A opcao Transpose (Transposi¢cdo) possibilita transformar o sistema de
coordenadas do plano de trabalho.

Tranzlate E |

aeneral |

[ Copy [~ Dynamic

£ |<N|:|ne> YI # |<N|:|ne> vI
Repeatz I 3: Layer I vI

] 4 I Cancelar | Ajuda |

A opcéo Translate (Translagéo) possibilita movimentar a peca em qualquer
direcdo. Selecionando a opcado Dynamic (Dinamico) possibilita o
reposicionamento da pega com o uso do mouse.

As opcdes Z e X oferecem a possibilidade de efetuar movimentos com
medidas determinadas, bastando digitar o valor numérico desejado na caixa
correspondente.
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